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CAJSE: COMPUTER-ASS1STED JOB SKILL EVALUATION PROJECT:

FINAL REPORT

The following final report summarizes the progress of a project designed

to develop an evaluation software instrument and to deploy and evaluate the use

of notebook computers and portable printers as a means of providing immediate

performance evaluations in technical-vocational career education. The report is

divided into a brief overview of the project, a review of how formative objectives

in the project were achieved, a report of a study exploring the overall

effectiveness of the project, and recommendations for similar projects in the

future. Examples of computerized evaluations instruments are attached to this

report along with a computer disk containing the work product of the project. A

brief manual for using the computer applications based on the Intelligent

Questionnaire with the Write One also accompanies the report.

PROJECT OVERVIEW

Relevance to State Mandates.

The computer-assisted job skill evaluation project (CAJSE) advanced the

goal of improving technical education as set forth in the State's Master Plan for

Career and jechnical Education . Specifically, CAJSE addressed Objective 1-3

by assuring the integration of academic and technical education and Objective III-

1 by improving technical education instruction relative to industry skill standards .

Objective 1-3 of the Master Plan for Career and Technical Education

mandates colleges to strengthen programs by integrating academic curricula and

methodology with those employed in technical education. CAJSE met this

objective by transferring a proven method of improving student skill,

1



www.manaraa.com

computerized performance evaluation, developed in an academic field, speech

communication, to technical education. Revising selected technical programs in

this way means that academic and technical education assume a greater degree

of integration thus, improving technical education.

Objective III-1 of the Master Plan further mandates that community and

technical colleges in Texas should enhance technical education instruction with

respect to business and industry standards. Strategy III-1 a, proposed to

accomplish this objective, encourages the development of institutional processes

designed to improve technical education and increase successful student

outcomes. As a result, student competencies in technical skills will improve.

Tarrant County Junior College shall assume a leadership role toward this end by

implementing an institutional process designed to improve student outcomes,

computerized performance evaluation, in several of the technical education

programs it offers.

Using Resources and Personnel.

Organizational structure for the project involved a Project Director, ten

Evaluation System Developers,and one half-time secretary. The project director

monitored designed the overall project and the activities of the project, submitted

progress reports to the Coordinating Board, scheduled meetings of the project

advisory committee, authorized payment of project consultants, authorized

purchase of equipment and supplies for the project, consulted with the evaluation

system developers. The Project Director received a 20% reduction in teaching

load in exchange for these duties.

Ten instructors, selected from technicaU focational education programs at

Tarrant County Junior College, developed computer-assisted job skills evaluation

software for their courses. These technical educators or Evaluation System

2
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Developers attended project workshops, converted existing evaluation tools into

a computer-assisted format, prepared corrective advice for each level of job skills

proficiency, incorporated the instructional commentary into job skills evaluation

software called the Intelligent Questionnaire, implemented the computer-

assisted job skills evaluation system in their courses, evaluated the effectiveness

of the computer-assisted job skills evaluation system. Each Evaluation System

Developer received the equivalent of one course of overload pay and benefits in

exchange for their participation in the project.

FORMATIVE OBJECTIVES ACCOMPLISHED

CAJSE personnel successfully completed the formative objectives of the

project. The following activities illustrate how the CAJSE project performed

during the term of the grant.

July 1, 1994 - September 30, 1994

During the first quarter of the project CAJSE provided software and

equipment to project participants, trained project participants to use IQ software,

and selected clinical evaluation instruments for conversion to the computer-

assisted format.

Computer hardware was purchased and distributed to all Evaluation

System Developers involved in the CAJSE project. One notebook computer was

purchased for each of the ten instructors selected from vocational/technical

programs at Tarrant County Junior College and the Project Director. Each of

these personnel received one Apple Macintosh model 150 notebook computer

and one Apple StyleWriter ll portable printer.

3
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Computer software was purchased and distributed to all instructors

involved in the CAJSE project. One copy of performance evaluation software,

The Intelligent Questionnaire with Write One (IQ), was purchased for each of the

ten vocational/technical instructors and the project director. IQ was purchased

from Performance Guild Associates of Granbury, Texas who publish the software

package.

As part of their training, all project participants attended workshops

designed to familiarize them with the goals of the project, IQ software and

computer equipment. In addition, project participants attended a workshop

designed to teach them how IQ stationery documents enable a completed

questionnaire to produce a set of personalize evaluation comments, tailored

specifically to the performance of each student.

Instructors designed stationery documents based upon their existing job

skill performance rating instruments. The instructors also began to adapt their

current evaluation criteria into IQ questions and compile job-skills questionnaire.

Project consultant C. L. Turner of Performance Guild Associates provided

individual assistance to all ten of the faculty involved in the CAJSE project.

October 1, 1994 - December 31, 1994

During the second quarter of the project, CAJSE personnel developed and

began to incorporate performance comments into IQ software, tested and refined

the IQ stationery and evaluation questionnaires. Developers were advised to

prepare an extensive instructional commentary for each level of student skill

proficiency they planned to evaluate. At this point, several software developers

found the IQ application difficult to use to assemble a coherent and uniquely

individualized evaluation out of descriptors and phrases stored in the evaluation

questionnaire. However, several developers added performance-related

4
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comments to their job skill evaluation questionnaires. Individual help was

provided by the software consultant to remediate these conceptual limitations

concerning software development.

January 1, 1995 - March 31, 1995

Developers began initial or pilot testing of the computer7assisted job skill

evaluation system. Instructors received individual help from software consultants

to refine and perfect their software applications of the IQ software. During this

time some practical limitations to the planned system were encountered. These

are noted in the discussion of results section of the report. Developers adopted

refinements to their IQ stationery and qu6stionnaire files. Following these

refinements, software developers began to implement computer-assisted job skill

evaluations in clinical and laboratory settings.

April 1, 1995 - June 30, 1995

A comprehensive evaluation instrument, reflecting the summative

objectives of the project, was developed and used to assess the overall

effectiveness of the CAJSE project. Construct validity for the CAJSE rating scale

was established when a factor analysis of the items revealed the four principal

dimensions expected.

5
1
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SUMMATIVE OBJECTIVES ACCOMPLISHED

CAJSE was organized around four basic assumptions concerning

computer-assisted performance evaluation.

1. CAJSE will promote consistent, and hence reliable, evaluations of

student job skill performance in clinical and laboratory settings .

2. CAJSE will provide technical/vocational students with

comprehensive corrective feedback.

3. CAJSE will produce high levels of student skills proficiency in

clinical and laboratory settings.

4. CAJSE will permit efficient use of instructor's time in preparing job

skill evaluations.

A study, based upon student ratings was designed and implemented to

examine the extent to which the project accomplished the summative objectives.

The results of this evaluation study are reported below.

EVALUATION STUDY

Hypotheses

In light of the summative objectives of the project, the following

hypotheses were advanced:

H : Technical-vocational students will report that CAJSE software

permits consistent job skill evaluation.

H2: Technical-vocational students will report that CAJSE software

provides comprehensive correctional feedback.

H3: Technical vocational students will report that CAJSE software

produces instructional feedback that is relevant to effective job skills

performance.

6
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H4: Technical-vocational students will report that CAJSE software

promotes instructional efficiency.

General Procedure

Subjects were 77 technical-vocational students enrolled in the programs

for which the CAJSE project had a completed questionnaire. All subjects

performed a job skill and received computer-assisted feedback immediately

following their performance. Subsequently, each student completed the CAJSE

rating scale.

Instrumentation

The CAJSE rating scale consisted of thirty Likert-type items representing

the four major summative objectives sought by the project. Specifically, in order

to be successful CAJSE software should promote consistent job-skill evaluation,

provide comprehensive corrective feedback, produce student skills proficiency,

and permit efficient use of instructional time. Equal number of items assessed

the positive and negative aspects of each factor. Internal consistency for the

CAJSE rating scale, estimated by the split-half methods, was .77. Coefficient

alpha for the scale was .94. Therefore, the CAJSE rating scale proved to be a

reliable measure of project effectiveness.

Student ratings of CAJSE software were factor analyzed. The varimax

solution confirmed the existence of four independent factors or dimensions in the

evaluation tool. Data in tables 1 - 4 show the factor loadings and communality

estimates for each CAJSE rating scale item.

7
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Table 1.

Factor loadings for riAJSE Rating Scale Items on tbe Evaluation Consistency

Dimension.

Varimax Solution

Item # Communality Factor 1 Factor 2 Factor 3 Factor 4

Item 2 .659 .734 -.066 .234 .248

Item 4 .685 .806 -.005 .184 -.045

Item 19 .607 .568 .099 .289 .347

Item 23 .776 .766 .352 .072 .246

Item 25 .750 .707 .280 .392 .133

Item 29 .723 .807 .162 .165 .135

Factor one accounts for 25.95% variance among factors.

8 14
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Table 2.

Factor loadings for CAJSE Rating Scale Items on the Comprehensive Feedback

Dimension.

Varimax Solution

Item # Communality Factor 1 Factor 2 Factor 3 Factor 4

Item 1 .702 .085 .756 .250 .245

Item 3 .714 .178 .710 .076 .415

Item 7 .571 .193 .564 .397 -.240

Item 9 .818 .342 .811 .101 .183

Item 11 .761 .276 .799 .078 .200

Item 12 .822 .114 .897 .027 -.063

Item 14 .826 -.233 .772 .318 .272

Item 27 .749 .062 .528 .308 .118

Factor one accounts for 24.85% variance among factors.
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Table 3.

Factor loadings for CAJSE Rating Scale on the Skills Relevance Dimension.

Varimax Solution

Item # Communality Factor 1 Factor 2 Factor 3 Factor 4

Item 13 .789 .172 .211 .834 .138

Item 18 .779 .288 .147 .807 .148

Item 20 .801 .274 .271 .805 .064

Item 21 .711 .322 .124 .721 .269

Item 22 .489 .135 .297 .602 .141

Item 24 .427 -.052 -.036 .627 .174

Item 26 .769 .095 .009 .814 .312

Item 28 .740 .264 -.013 .802 .165

Factor one accounts for 29.8% variance among factors.
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Table 4.

Factor loadings for CAJSE Rating Scale Items on the Instructional Efficiency

Dimension.

Varimax Solution

Item # Communality Factor 1 Factor 2 Factor 3 Factor 4

Item 5 .641 .094 .432 .077 .663

item 6 .632 .355 .096 .096 .572

Item 8 .595 .306 -.162 .255 .640

Item 10 .510 .394 .108 .343 .745

Item 15 .707 .055 .157 .172 .631

Item 16 .752 -.147 .204 .277 .782

Item 17 .741 .396 .199 .373 .636

Item 30 .457 .294 .118 .313 .509

Factor one accounts for 19.4% variance among factors.

11
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Each factor was operationally defined by the scale items listed below.

Numbers preceding each scale indicate the order in which the item appeared on

the rating instrument. The sign in the parentheses indicates the valence of the

item, i.e. "+" means a positive trait cf the factor, "-" means a negative trait of the

factor.

Factor One - Evaluation Consistency.

2. The trainer's comments told me in specific terms how well I performed on

this assignment. (+)

4. The trainer only told me what I did well in general terms. (-)

19. My evaluation was based on a set of performance criteria or recognized

standards. (+)

23. My grade on this assignment was based strictly on participation or simply

completing the assignment without consideration of performance standards. (-)

25. The trainer recognized improvement in difficult areas for me. (+)

29. I felt my grade was given without respect to how hard I tried or how much

improvement I actually made. (-)
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Factor Two - Comprehensive Feedback

1. The computer-assisted job-skill evaluation provided enough comments to

help me improve my performance. (+)

3. The computer-assisted evaluation did not give me enough information to

help me improve my skills performance. (-)

7. Compared to other performance appraisals I have received, I would say

the computer-assisted job-skill evaluation was among the most thorough. (+)

9. The computer-assisted performance evaluation provided least feedback I

have ever received. (-)

11. The, computer-assisted performance evaluation gave me adequate

information on how well I did on the assignment. (+)

12. My evaluation gave me no information on how to improve my future skills

performances. (-)

14. The trainer made me aware that my success was a product of my own

effort and ability. (+)

27. The trainer made me feel my success on skills performances was due to

luck or an easy assignment. (-)
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Factor Three - Skills Relevance

13. The instructor's comments showed he/she was paying attention to my

performance. (+)

18. Comments on my performance appraisal showed little attention to my

performance (-)

20. The computer-assisted performance evaluation focused on those

behaviors most relevant to a successful performance. (+)

21. The computer-assistad job skill evaluation made it seem that I was

performing for the teacher's amusement. (-)

22. The trainer's comments explained how changes in my behavior could

produce improvement in future performances. (+)

24. The instructor's comments made direct comparisons to how others

behaved. (-)

26. The trainer made me feel that learning to perform a skill effectively was fun

and/or interesting in its own right. (+)

28. The trainer made me feel that I was learning to perform job skills to win a

competition or to please him/her. (-)
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Factor Four - Instructional Efficiency

5. Comments were delivered immediately following my job skills

performance. (+)

6. Comments were delivered in a random and unsystematic manner. (-)

8. Overall, comments on my computer-assisted performance evaluation were

very helpful. (+)

10. My computer-assisted performance evaluation was not helpful at all. (-)

15. After reading my job skills evaluation, I was able to clearly see how my

performance could be improved. (+)

16. The instructor's comments made me aware of how my performance

compared to that of others in the program. (-)

17. After reading the evaluation, I had a greater appreciation of the skills I was

asked to perform during the job skills performance. (+)

30. Computer-assisted evaluation distracted me from learning to execute my

performance effectively. (-)
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RESULTS OF THE EVALUATION STUDY

Hypothesis One.

Technical-vocational students reported that CAJSE software provided

significantly higher levels of evaluation consistency (mean =13.208) than

evaluation inconsistency (mean = 7.494, gif = 76, mean difference = 5.714, / =

16.742, p < .0001). Expected difference between positive and negative traits

concerning the consistency of job skill evaluations were assessed using a one-

tailed / test for paired samples. The results of this statistical test are reported in

Table 5.

Table 5.

Difference Between Positive and Negative Traits of Evaluation Consistency.

I - test

DI, Mean X - Y Paired / - value 12 (1 - tailed)

76 5.714 16.742 .0001

Hypothesis one was supported.

16 22
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Hypothesis Two.

Technical-vocational students reported that CAJSE software provided

significantly more comprehensive feedback (mean =17.818) than incomplete

instructional feedback (mean = 15.844, f = 76, mean difference = 1.974, 1 =

6.922, p < .0001). Expected difference between positive and negative traits

concerning comprehensive feedback were assessed using a one-tailed 1 test for

paired samples. The results of this statistical test are reported in Table 6.

Table 6.

Difference Between Positive and Negative Traits of Comprehensive Feedback.

- test

12.E Mean X - Y Paired I - value (1 - tailed)

76 1.974 6.922 .0001

Hypothesis two was supported.

Hypothesis Three.

Technical-vocational students reported that CAJSE software provided

significantly more relevant feedback about job skills (mean =17.697) than

feedback irrelevant to job skills (mean = 15.844, j = 76, mean difference =

1.882, 1= 6.835, p < .0001). Expected difference between positive and negative

traits regarding the relevance of instructional feedback to job skills were

17
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assessed using a one-tailed I test for paired samples. The results of this

statistical test are reported in Table 7.

Table 7.

Difference Between Positive and Negative Traits of Skills Relevance.

1
I - test

DE Mean X - Y Paired / - value 2 (1 - tailed)

76 1.8823 6.835 .0001

Hypothesis three was supported.

Hypothesis Four.

Technical-vocational students reported that CAJSE software provided

feedback with significantly more instructional efficiency (mean =18.117) than

instructional inefficiency (mean = 17.645, gif = 76, mean difference = .487, / =

1.731, p < .0438). Expected difference between positive and negative traits of

instructional efficiency were assessed using a one-tailed t test for paired

samples. The results of this statistical test are reported in Table 8.

1
18 24



www.manaraa.com

Table 8.

Differenpe Between Positive and Negative Traits of Instructional Efficiency.

I - test

DE Mean X - Y Paired I - value 2 (1 - tailed)

76 5.714 16.742 .0001

Hypothesis four was supported.

DISCUSSION OF EVALUATION RESULTS

Advantages of Computer-assisted Job Skill Evaluation

Based upon the findings of the evaluation study, CAJSE portends several

advantages for the technical-vocational educator. First, CAJSE permits

consistent job-skills evaluations for technical-vocational students. In the initial

year of the project, CAJSE allowed instructors to inform students in specific terms

concerning how well they performed during assignments. Based on a set of

recognized standards and performance criteria, evaluators were able to

recognize gains in student proficiency while e:iminating ambiguous comments

and capricious grading practices.

Second, CAJSE provides students with comprehensive correctional

feedback. Computer-assisted job skill evaluations deliver ample amounts of

thorough comments to help students improve on future performances. Under

19
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CAJSE conditions, students become aware of how their own ability and effort

contribute to improved job-skills. Students generally thought the feedback they

received from IQ software was among the most thorough and helpful they had

ever received in a job related setting.

Third, CAJSE produces instructional feedback that is relevant to effective

job-skills performance. CAJSE corrective statements included enough attention

to the details of job-skills performances, students could understand how changes

in behavior produce improvements in future performances. This focus on

improving student behavior rather than on competing with others for grades or

performing to please the instructor's whims, is an integral part of successful

instruction.

Fourth, CAJSE promotes instructional efficiency. CAJSE provides

students with immediate, systematic performance feedback. This lead to a

greater appreciation among students regarding the skills they were asked to

perform. Technical-vocational educators are able to deliver more evaluative and

corrective information to students with greater rapidity than with traditional paper-

pencil methods.

Limitations of Computer-assisted Job Skill Evaluation

Despite successful completion of several pieces of evaluation software

and the general enervation provided by professional development activities such

as CAJSE, resistance to innovation did emerge. Essentially, these areas of

resistance represent conceptual and practical limitations unanticipated during the

formulation of the grant proposal.

Initially, CAJSE software developers displayed and later overcame

difficulty in understanding how the IQ software worked. Although CAJSE

software developers were computer literate, most of them were experienced in

20
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DOS/Windows operating systems exclusively. 10, an application running solely

on Macintosh computers, used an entirely different operating system than the

software developers anticipated. Some were skeptical that a Macintosh, which

they considered an inferior machine, could deliver as promised. Also, they

because they had never seen any software operate or perform like 10, CAJSE

software developers had trouble visualizing exactly how the program assembled

evaluation statements from observations of student performance. As a result

CAJSE software developers were apprehensive about successfully completing

the project. However, training sessions, including one provided by the College's

Management Information Services staff on the use of Macintosh computers and

another by the project consultant on IQ software remediated these problems.

Once the CAJSE software developers learned to use the Macintosh computer

and realizea that IQ software was not altogether mysterious, they acclimated

quite well to the project timetable.

However, a more interesting area of resistance to the CAJSE concept

surfaced during the development and refinement of evaluation software. In

particular, this pertained to using IQ software as a means of filling out existing

forms rather than providing corrective advice to students. For example, one

evaluation developer proposed computerizing a skills checklist. Although

behavioral descriptions of student activity were clearly stated, the focus of the

evaluation shifted from the quality of student performance, i.e., how well a skill

was executed, to the presence or absence of discrete behaviors. If the evaluator

observed all expected behaviors the student's job skill performance was deemed

competent. Failure by the student to emit desired behaviors indicated a deficient

performance irrespective to the actual affect the student's job skills had on the

client. Another evaluation developer resisted further software development

because state approved forms were used in that job field. This evaluation

21
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software developer expressed apprehension about generating a facsimile of the

form via computer. Both if these evaluators are presently revising their software

to accommodate these concerns. For example, the evaluation system developer

whose concern was posed for using the right state-approved form has agreed to

revise the software concept for laboratory or classroom practice sessions. These

exercAses employ rating sheets devised by local faculty and have spaces

provided for corrective information.

RECOMMENDATIONS

Based upon the preceding discussion, the following recommendations for

future investigations and development of computer-assisted performance

evaluation are offered.

First, software developers need generous amounts of time in order that

they might optimizes chances for success. The act of developing computer

software, especially in an exotic application like IC), is a cognitively complex task.

Most technical-vocational educators will have little experience in software

development. In order to employ 10 based evaluation software they must learn

to visualize the evaluation process in a completely different way than before.

Although workshops and individual help from consultants was provided CAJSE

software developers a good deal of time on task was required before the task

became more clear.

Second, novice software developers should work from a template or

model. The greatest difficulties in understanding how to computerize an existing

evaluation system were experienced when CAJSE software developers tried to

compile their questionnaires from scratch. Later, as a result of individual

consultations by C. L. Turner of Performance Guild Associates with these faculty,
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progress came more quickly once the faculty began modifying an existing

questionnaire. Deconstructing a suitable model allowed CAJSE 3oftware

developers to understand the logic of the la application. Software publishers

should provide a template questionnaire from which novice designers could work.

Third, technical-vocational faculty who attempt the development of

computer-assisted evaluation software should know the difference between using

a computer to fill out or generate a completed facsimile of an existing form and

providing a unique performance evaluation personalized for each student. This

distinction is more than a simple matter of taste. If a faculty member merely

needs to generate completed form without corrective feedback, he/she should

investigate using off-the-shelf form generation software. Numerous software

packages presently available in both IBM (DOS/Windows) and Macintosh

operating environments will address this need without the expense of specialized

training. On the other hand, if the faculty member envisions using a portable

computer to create individualized performance evaluations the CAJSE project

model is advised.

Fourth, future studies of computer-assisted performance evaluation in

technical-vocational education should employ or modify the CAJSE rating scale.

Although these rating scale items were initially developed to reflect the four

summative objectives of the project, factor analysis confirmed the original

dimensions of evaluation consistency, comprehensive feedback, skills relevance,

and instructional efficiency. Moreover, the scale demonstrated internal reliability.

Future investigators could adapt these scales and employ them as a means of

evaluating the effectiveness of computer-assisted performance evaluations.
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Intelligent Questionnaire With TheWriteOne

Chapter.

Introduction..
STARTED

1

GETTING

This is a short chapter telling you how to get started with Intelligent
Questionnaire With The Write One. It contains

System Requirements

Prerequisite Skills and Knowledge

Starting Intelligent Questionnaire With The Write One

Personalizing Your Disk

FolfilHng Your Copyright Agreement

Chapter 1
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system Requirements
To use Intelligent Questionnaire With The WriteOne you will need at
least the following:

Macintosh with at least 1 megabyte of memory with

System 6.0.2 or later, and

800K disk drive.

prerequisite Skills/Knowledee
This manual assumes you already have read your Macintosh System
Software User's Guide and have a good working knowledge of the
Macintosh Graphic User Interface. If you don't, please read the
Macintosh User's Guide to become familiar with the terms used in
the book and follow the basic tutorial.

Starting Intelligent Questionnaire With The WriteOne

.1. Turn on your computer.

2. Insert your Intelligent Questionnaire Wah The WriteOne master
application program disk in the internal disk drive.

The disk files and folders should look something like this:

Chapter 1

III With The Write One'" ti
i Moms 703 MI% OW GA MI mirk*

le Yilk

for Hooke

1 .

I:3
Thy ~No" OpoojlosoCariOoMtlobjelook

*L_J

111

r--
444

1.04 61

V:n1
or Foo1or

Cli . ti

Page 2 of 4
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3. Perform these operations in some order:

Open the folder indicated. It should look something like this:

11:1111IN Open,PleceContents In System
4 111444 70.3 PO in ft& SA MB avast*

ED
Claris Traraislers

Parts

VILMeinift

*Om

Ohl
Z.7111

Epl
WO-LlearDls

(0,
X110

471 I

Copy the CONTENTS of the folder to the System Folder.

For Macintosh System 7. users, Claris Translators and
1461" Claris XTND System must be placed in the Extensions

Extensions folder.

Open the Intelligent Questionnaire With The WriteOne
application.

1. Click the Intelligent Questionnaire With The WriteOne
application disk icon to select it.

2. From the File menu choose Open.

The first time you open the application the following dialog box will

Chapter 1

aPPe!Ill

Meese register Ibis sew copy et IliritelhoWn.

UMW Nosy
Cermieeg Nome:

Serial Nviabor:
.4116.

OK

Page 3 of 4
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personalizing Your Disk

1. In the dialog box that appears, type in

Your name

Your company's name (optional)

Serial number (located in the disk packet).

2. Check the information.

( This is the only chance you will have to MAKE SURE the
information is correct.

3. Click the OK button.

Fulfilling Your Copyright Agreement

Chapter 1

If you as an INDIVI-
DUAL user are using:

And You
Retain for
Archival:

HARD drive CoPY
hard disk. Original

FLOPPY Make ast* copy. Original or copyIs

Hard drive
SIR

Floppy drive

A *Dedicatedcomputee
An of tbe
time.

Make one
additional

c°PY for < 2"time use on a
home computer.

Page 4 of 4
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Chapter

The Basics. Creating A Document

In this chapter, you will learn how to create a short document and
how to make some basic editing changes to it.

You will perform the following operations:

Typing Text

Selecting and Deleting Text

Saving a Document

Opening a Document

Closing a Document

When you first start up Intelligent Questionnaire With The WriteOne
a default, blank window will open. This is the WriteOne
WORDPROCESSING AND GRAPHICS function. The Intelligent
Questionnaire function is enabled by choosing <a>> on the menu.

Ns UN us fael ONO I U. eb

Chapter 2

Page 1 of 5
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Typing Text

Type characters on the keyboard remembering NOT to press return
until the end of the paragraph.

Use the backspace key (or delete key on some Macintosh
computers) in the event of a typing mistake.

Insert text by pointing with the mou.se and eliciting the pointer
(I-beam) between the words or letters where you wish to type.

selecting and Deleting Text

1. Position the pointer (I-Beam) where you wish to start.

2. Drag until the word(s) or letter(s) in the word is(are) completely
highlighted.

3. Press the backspace key (or delete key) to delete the word QE
start typing and the selection will be replaced.

Saving a Document
Ile

Now
Sou
alms

X0
XW

S (1 S

Ws SC«
Sate selection...
Itonort

Preferences
Pogo Margins...
Pogo Setup
Print XP

I Chapter 2

Now
Open...
Class
Sous

XO
KW
XS

Save selection...
land
Preferences...
Pogo Margins...
Pals %top
Print XP

Quit X0

Page 2 of 5
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If you are Saving
a Document:

And you wish to
Save the Document:

Then from the File menu choose:

- .

That has already
been TITLED.

a TITLED Save

With a NEW TITLE
Saue as...

The following dialog
box will appear. -

Has NOT
been titled. Iv-

Saue Qg Saue as...

The following dialog
box will appear.

II

(=Macintosh NO

C3 Dpplications
0 110114111, I i92
C3 Cutler Projects
C3 Dated Naps
C3 lanes Templates
C3 10 Stuff

Sees as.../Eupert File
WrftsOes

liop ter I

mackdosh NO

f jin t

I Desktop

Save

Cancel

1. Select location, format, and title in some order:

Select the LOCATION for the file to be saved.

Select a disk by clicking the Driue and/or Eject (or
Desktop) buttons as necessary.

Select a folder or disk using the scroll box pop-up menu.

Select the FILE FORMAT using the File Format: pop-up
menu.

Type in tne Saue as: box the TITLE you want for your
document.

2. Click the Saue button.

Page 3 of 5
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Opening A Document

Chapter 2

File

New
Open...
Close
Salm
Savo as...
Sous selection...
Reuert

KW
NS

Preferences-.
Page Margins...
Page Setup
Print UP

quit U0

1. From the File menu choose Open...

The following dialog box will appear:

Select a flio to open

C3 Knee Enamels
C3 Macl.lakPles
C3 McBride Enamels
C3 NetWeek Felder
0 MN Nereaseat
C3 Remote lielewes
0 Steckbeldees Agreement
C3 System feeder
0 Temaletee,11/11 /92

Show: mi evellable

1=3 Macintosh NO

Eject

liesktop

Seen

Cancel

2. Select LOCATION and FILE TYPES in some order:

Select the LOCATION of the file to be opened:

Select a disk using the Drive and/or Eject (or Desktop)
buttons as necessary.

Select a folder or disk using the scroll box pop-up menu.

Select the FILE TYPES using the File Types: pop-up menu.

3. Click the Open button QB, double-click the file/folder name to be
opened.

Page 4 of 5
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Closing a Document

* Re Edit

Chapter 2

New
Open... No
( lose as,L11

sews Ns
Saw es...
$eve
laved

Preferences...
Pegs Margins...
Pegs Setup
Print

Ouit

1. To CLOSE a document (window), from the File menu choose
Close,

Click while the pointer is in the left hand white box of a window's
title.

2. WriteOne will ask if you want to keep any changes to your document,
if any changes have been made since the document was last saved.

Setw changes to : WdteOne
Oecoosentetion?

OE=

Page 5 of 5
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3
More Basics Revising a
Document

Now that you can perform the basics of creating and editing a document,
you are ready to modify an existing document.

In this chapter, you will learn the following operations:

Beginning a Document

Scrolling Through a Document

Moving Text with Cut (or Copy) and Paste

"Redlining" a Document

Finding (& Replacing) Text Revision

Saving Text Revisions

Chapter 3

Page 1 of 11

4 0



www.manaraa.com

1

Intelligent Questionnaire With The WriteOne11.3

lieginning a Document

If you wish to: From the File menu choose:

Stan a NEW
document.

New
A new untitled WriteOne
document will appear.

Open an EXISTING
document.

,

Open...
Follow the steps, Opening I
Damming,

Scrolling Through a Document

Scrolling means moving the text through the window to bring different
parts of the document into view.

WSW heels tem Mee 14106 Stew st
NSIflhsI

CD 1

Click dr 'up'
arrow* Po above

Page 2 of 11
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Use the decision table following and the picture on the preceding page
for scrolling a document.

To Adjust the Text
in the Window:

Click:

LINE-BY-LINE
(approximately).

While over the
"up" or "down"
ARROWS.

By SCREEN
LENGTHS.

Above or below the
white box (THUMB)
inside the scroll bar.

By scrolling FAR
into the Document
QUICKLY.

While OVER the scroll
bar THUMB and drag it
up or down to the new
location.

moving Text With Cut (or Copy) and Paste

dit
Can't Undo X2

.11

Copy SIC

Paste
Deer
Select All

Se to Page... XS
Load Documents...

dil

Type Literal.

Can't Undo UZ

Cut liii

Paste
Cher
Select All

ITU

XA

Se to Pogo XS
Load Documents...
Type Literal-

1

.1

Page 3 of 11
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1. Highlight the text with the pointer.

2. From the Edit menu, choose CU t (or Copy).
(The text is now on the clipboard).

3. Place the insert point where you wish the text to be placed.

4. From the Edit menu, choose PaSte.

"Redlining" a Document

Chapter 3

Several methods are useable to "redline" a document with WriteOne. We
use shading, a Backlight Mark, to sh6w new language; a line drawn
through words (Strike Through) to show deletions, and a Read Line
Mark to show paragraphs affected.

Style
vPiala UN

Bali KB
Ki

Walnut Ku
DAM
Olva amp
Super Script KI
Sub Script KI

Styles

'semi i Ine Mat k
Strike TWa St/
Backlight Mork SI;

laden Mark
TOC Mara .

Style
inch% UN

Bald KB
Itale at
lInthullaa KU

Obnaan
SuperScript KI
SOW'S

Styles...

Read Lies Mart
Str e I !du /

Backlight Mart U;

laden Mark
TOC Matt

Style
Plata UN
ileM KB
Oak KI
IbuterUna KU
MOM
01Xuamo
superscript *I
SubScrIpt etl

Styles...

hese Una Matt
Strike Um X/

kluqrit Mdtk

laden Mark
TOC Mark

When a paragraph needs to be MARKED AS CHANGED (REVISED),
as in a read line:

1. Place the insert point anywhere in the paragraph.

2. From the Style menu, choose Read Line Mark.

Read Line Marks appear at the right ofthe text at the margin like the
example on the right.

Page 4 of 11

4

BEST COPY AVAILABLE



www.manaraa.com

Intelligent Questionnaire With The Write One

Chapter 3

When you wish to use SHADING to "BACKLIGHT" words:

1. Select the text by highlighting that you wish to graireiiithAggit
[KEY.

2. From the Style menu, choose Backlight Mark.

When you wish to STRIKE THROUGH text:

1. Select the text by highlighting that you wish to strike through.

2. From the Style menu, choose Strike Thru.

You may accomplish the previous operations (Read Line Mark,
Backlight, or Strike Thru using this procedure as well.

1. Select the text by highlighting that you wish.

2 From the Style menu, choose Styles....

The following dialog box will appear:

Fent:

Custem Style

Size:Times 12

ISPlein 13tondense

1311eld 13Enteed
CI Me De 1364,111,41we

08200r1D2 01117.11frr

001)DIND None

[Iiirws 1) 111 k

Color: Bleck

1-11Maedie
0 11allatlat
0 not. Underlint

13 Stertlip Default.

Odd

Modify

nemove 12C773

3. Use the check box for Strike Thru,

1:164.1ke-Thmt

OR,

Page 5 of 11
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Use the Pop-up menu above ti scroll box to select your choice.

:04 Super Script
In Sub Script
PostScript

Backlight
laden Mark
TOC Mark

None

Finding (& Replacing) Text or Style Revisions

You can use Find from the TOOIS menu to Find & Replace tabs,
words, or styles.

11M61Spelling M11111"IIIIIIIIMIIMb
Macro List b
Paste Stamp b
Case Change b

Voice InnotetWn

Enter Selection SCE

Find again UM
Replace SI
Replace & Find again SA
Replace MI

Indeu/TOC...
Tile Windows...

When you select Find from the Tools menu, the following dialog
box will appear:

Find

Search for :

1:3 ignore case.
la Wrap *round.
CI Whole words.

Taut Replace with : Tout

Find Isn't find ( Cancel

Page 6 of 11
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Chapter 3

If you wish to find/replace: Then:

Tab(s)

Use the pop-up to select Tab to find and/or replace.

Seen* far : teet
- .

I
la

Word(s)

Use the pop-up to select
following procedure for
Word(s):

Waft Tar :

TERT and
Finding

ieNt

T66

use the
& Replacing

0511

StYle(s)

Use the pop-up to select Style....

Monk tor : ha
I

TO

When the dialog box appears
procedure for Finding &

use the
Replacing

following
Style(s):

ceders thole
maul I Wsel I Calia:

Mau Opollsoss
011eld 056166. 0 MUM
OM& 01401110-11me 0 Ilakkeiadi:1
01101011108 OlarW
DIM= Nam I

CI Moil* Warm

ma

Meets INC

I loom 1-q-771
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Finding (8r Replacing) Word(s)

1. Decide on the word(s) you wish to find/replace.

If the word(s) words must be
consecutive you wish to
find/replace are:

Then:

NOT readily seen on the document.

From the Tools menu, choose Find,
and then from the submenu select Find...

The following dialog box will appear:

Can be readily highlighted
on the document.

1. Highlight the selected word(s).

2. From the Tools menu choose Find,
and then from the submenu select
Enter Selection.

3. From the Tools menu choose Find,
and then from the submenu select Find...

The following dialog box mil appear with
the selection entered in the Search for: box:

2. Verify La type in the Search for box the word(s) you wish to
find.

3. Use the check boxes to search as needed:

Checking Ignore case. will search for words without regard
to UPPER CASE or lower case.

Cbecking Wrap around. will search from the cursor
position, wrap around the end of the document, and return to the
starting position.

Checking Whole words. will search only words with leading
or trailing word breaks (spaces, punctuation, and tabs). The
WriteOne will find only the words NOT embedded in text with
this box checked.

4. Enter the word(s) in the Replace with: box that you want to use
as REPLACEMENTS for the word(s) you find. You may also
choose to replace with a tab or a style.

Page 8 of 11
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Chapter 3

5. Start the search.

If the word(s) you wish
to find/replace is(are): Then:

HIGHLIGHTED
You may click the button labeled
Don't find to treat the highlighted
word(s) as thefirst occurrence.

NOT highlighted Click the button labeled Find.

6. Use selections from the Tools menu to

Find Again, DE

Replace, ga

Replace C, Find Again, gm

Replace fill

11111111117 Find
Spoiling
Macro Ust
Paste Stamp
Case Change

deice Annotation

Enter Selection UE
Find Again UM
leplace
lepton it Find Again le\
Replace Ill

humane
The Windows...

Page 9 of 11

48



www.manaraa.com

Intelligent Questionnaire With The Write One v1.3

Finding (& Replacing) Sty!e(s)
1. Decide on the styles(s) you wish to find/replace using the dialog box

that appeared after selecting Style.., from the pop-up menu.

Font:

Origin
Ole ld
13 /Mk
0101 BUDD

Onhoras

Custom Style

Size:

Manama
ClEastend

None

Calor:

F0

Underline

M DAMAO

Dot. Underling

startlip Default.

Add

( Modify

I Remove

OK

Cancel

2. Use the pop-up menu's, check boxes and radio buttons to select style
search criteria.

3. Click the OK button.

4. The Find dialog box will reappear.

Checking the Wrap around. checkbox will search from the
cursor position, wrap arowd the end of the document, and return to
the starting position.

5. Enter the text, tab or style in the Replace with: box that you
want to use ts REPLACEMENTS for the style(s) you fmd.

6. Click Find.

Chapter 3
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7. Use selections from the Tools menu to

Find Again, 01

Replace, Qa

Replace C. Find Again, DR

Replace 011.
loots

Spelling 0
Macre List 0
Paste Stamp 0
Case Change 0

Voice lInnotetIon

Find... XF
Enter Selection WE

Find again KM
Replace It
Replace It Find Rgain St\
Replac MI

Inden/TOC...
Tile Windows...

saving Text Revisions

From the File menu, choose Saue QR Saue as... and follow the steps
described in Baying a Document.

Chapter 3
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Chapter
1 1

Producing Output...piinting
WriteOne produces a printed output on the page in relation to your
placement of margins, headers, footers, etc. Other effects can be
achieved by your use of Stack Printing Order. This short chapter
describes:

Stack Printing Order

Printing A Document

Page 1 of 3

Chapter 1.1 51.



www.manaraa.com

Intelligent Questionnaire With The Write One v1.3

stack Printing Order

Stack Printlog Order

#1 - Overlay Form(s)
12 Header Pktures I Drawinp

- Header PostScript & Text
#4 Document Moores / Drawinp
05 Moment Text
06 - Fatter Mures I Drawings
07 - Rooter PostScript & Text

Page 2 of 3
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Printing a Document

If you wish to PRINT a
WrikOne document

Thew

With Writethie
OPEN

1. OPEN the DOCUMENT you wish to print.

2. From the File menu, choose the word Print. -

A dialogue box consistent with the printer selected
in the Chooser will appear.

3. Select PRINTING OPTIONS.

4. Click the OK button.

The FINDER

1. Select all the. FILES you wish to print.

2. From the File menu, choose the word Print.

When WrittOne opens, a dialogue box mnsistent
with the printer selected in the Chooser will appear.

3. Set PRINTING OPTIONS for ALL DOCUMENTS.

I

4. Click the OK button.

Chapter 11

To print forms on the page before the text of the document, see
Chapter 6, Usina Pictures and Drawing& topic Eigsztim
Printer Forms.

*Note the print order of a document's content on
previous page.

Page 3 of 3
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Chapter

1 2
Intelligent
Questionnaire. Preview

Intelligent Questionnaire With The Write One employs an
Interactive, Intelligent Questionnaire that you may use to model an
EXPERT SYSTEM by custom defmable rules and custom editable
report output.

Preview

General Ptocedure

Guidance Procedure

.1111111.01110110

Ma-

C..""
MINIMMOIMI0110INIMM.4, somiwom.1001aw1/....... 01111
MEMMIII
4111111

a 71 C 177 771.:1PE
I 1

Nee 11=111
Jo r-r-namilirlw ,.; WM Pala IleOlemilts

C3
-11-771

Chapter 12

wilmew

Naaschse
INNO06
Sebosadlbular

W Ikelte foreasefts
iNelvad Melee
11101 NM
Taseememalmilar
stalealee

ilINIPM111

S WAY Poise
tom Ifippms
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Preview of PREVIEW for Ouestionnaire

Intelligent Questinnaire is a RULE-based system that allows you to
define your own rules. The rule set is an EXPERT SYSTEM of
Questions-Answers that may be logically linked.

The output is placed in a TEXT and GRAPHICS processor that is
fully editable.

The parts of the System are...

The merge document (stationery) with "ID Merge Fields"...

I.Q. Functionsfunctions may be placed in the document or
work in concert with functions in the Questionnaire to
perform such functions as database lookup, test, case
change, page break, search, set value, arithmetic, etc.

The Questionnaire with...

Questionnaire ID'swhich will merge into the document
ID Merge Field of the same name. You may write a
question "prompt" for each Questionnaire ID.

I.Q. Functionsfunctions may be placed in the
Questionnaire or work in concert with the functions in the
Document to perform such functions as database lookup,
test, case change, page break, search, set value, arithmetic,
etc.

Answerssingle or multiple type and formatted as radio
button, check box, list, edit field, phrase, or phrase list.

Chapter 12

Merge TextThis is the actual "form" of the answer that is
the document output. Two forms of the same answer can be
developed: Primary Merge and Secondary Merge.

Page 2 of 15



www.manaraa.com

("Mary states that she smokes about one pack of cigarettes aday.")

Intelligent Questionnaire With The Write One v1.3

General Procedure for Questionnaire

The most general description is this:

For USING the Questionnaire:

1. Answer the Questionnaire-based answers for all document
merge fields. (One or more Questionnaires).

2. Merge Primary (or Secondary) language with the open
document.

For DEVELOPING the Questionnaire:

1. Develop the OUTPUT document.

2. Develop all the alternative questions-answers which produce
the output and make the logical relationships.

3 . Write the form of the answers for the output.

Guidance Procedure for Questionnaire

Developing A Questionnaire:

Example:

1. Developing the Output

This is a medical statement you presently record from a clinical
patient:

Chapter 12

Analyze the statement

"Mary" is the preferred name reference of the patient.
"she" is a personal pronoun reference.
"smokes" is the object; he(she) smokes or not.
"about one pack of ci arettes" is amount (could be none or any
amount AM is DEPENDENT on "smokes").

Now, rewrite the statement in general terms with
"PLACEHOLDERS" like this...

Page 3 of 15
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Intelligent Questionnaire With The Write One v1.3

The brackets contain our "trial merge fields." The final merge
document statement might look like this...

2. Develop all the alternative questions-answers which produce the
output and make the logical relationships.

Basic Analysis: What is NAME?

"Mary," "preferred name," or [PName] is the phone book and
then some. Rather than attempting a list of ALL possibilities,
use an "edit field" for this.

Basic Analysis: What is PERSONAL REFERENCE?

11

"she," "personal reference," or [PRef] could be these
possibilities: he, she QB, his, her.

Basic Analysis: What is OBJECT'?

"smokes" placeholder, [smokes], can be these possibilities
"does not smoke," "smokes less than one pack a day," "smokes
about one pack a day," or "smokes more than one pack a day,"
OR other such object data.

3. Replace "placeholders" with ID merge fields.

SUMMARY:

We generalize a typical OUTPUT DOCUMENT with
"placeholders."

We have NAME, PERSONAL REFERENCE, and OBJECT
(smoking) to be developed with appropriate logical linkage. For
these attributes of the statement, we then develop a
QUESTIONNAIARE.

1
Then we replace the "placeholders" with the ID Merge Fields.

Page 4 of 15
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For this out put:

[PName] states that [PRef] [smokes].

Develop the questionnaire:

1. NAME. Preferred Name or PName.

Chapter 12

--,Question List
I alEammi

Questionnaire Controls

larriks
ounrirm

0.I
re

=Earns 00117121111
Clallarlill 111:171122S1

=111
turime

Mc ( Steuart j
Untitled for Test

OK

OK P Newt

Answers

,

I

1

Preferred Name and Question Prompt and selection of Edit Field
as Answer Format.

Question Editor

Ig New: II-, m i e Type

Single Answer
0 Multiple

Question Preempt: 'A INI.a.Trifil
Whet Is Preferred Name?

Answer rennet -

0 'ladle Outten
0 Choc k eons
0ust

Edit field
0 Phrase

0 show as Hsi

Answers

'''

:4;

11112171
taaarni

0 1111.11:1 0
/il Kilt,

0 Vey break.
Question Link

0 Link. III... -
, OK '

Its 0
and§er 0

0 endow r Cancel
Wm long) thrurre
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[PName] states that [PRef] [smokes].

2. PERSONAL REFERENCE. 10 Name: PRO, Question
Prompt and selection of Check Boils as Answer
Format.

--
Question Editor

SO Name:IPHer Type

0 Single Answer
et Multiple

question Prompt: frn7 1

Whet are Personal References?

answer format-
0 Radio Button

Check Boas

0 list
0 frill FieW
0 Phrase

0 show as list

Answers
Or.
rt..
am.
no.
runs

ilz
New a)

13
Modify
Delete

1 uplicale

F Group break.
question Link

13 Link:I ID
OK

( Cancel )Item: 0 and
0 0 or 0

0 and0 of 0
and§ of LEJ

0 thou cling) thru alit

[PName] states that [PRef] [smokes].

3. OBJECT. ID Name: Smoking, Question Prompt and
selection of Radio Button as Answer Format.

Question Editor

III Name: Hkurig 1
Type

Slagle Answer
0 Multipie

question Prompt: tilizaTrin
Cos the patient Smoke?

lesiger Fennet
Redle Settee

0 Check Seas
0 List
0 EMI field
()Phrase

0 show as list

Answers

/to
I

I

I I
I I

IIMMErll
CIet=[10

Group break.
Question link

OK
,
-

(3 linic:1 M...

Item: 0 § andor 0
0 and
0 or 0 of

Cancel
Huy sang) thrill-fig
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Intelligent Questionnaire With The WriteOne v1.3

Chapter 12

4. OBJECT LINK. 10 Name: Packs/Day, Question

Prompt, and selection ofRadio Button as format.

Linkage with Question ID Name: Smoking, Item
Number: 2 (Yes).

Question Editor

10 Name: Pm k s dm Type

. Single Answer
0 Multiple

question Prompt: III Pk ker..-

flow many packs per day does the patient
smoke? Answer Format-

Radio Sutton
0 Chef k Sous

0 Ust
0 Edit Field
0 Phrase

CI show as list

Answers
t It wiry
r; i psekhlej

New SS

CI
Modify
Delete

1 a:Nicole

Group break.
Question Link .

OKCa Link:itsmokinp 10
0 and

1 unC:10 or 0or a
0 andiri
0 or ( Cancel j

0 Thrs Amy) 0 thrutail

5. Replacement of placeholders with ID merge fields.

Highlight the placeholder.

Choose ID Pick List.., from the menu.

New Questionnaire
Open Questionnaire St4
1.0. Functions... X5

Merye Primary X6
Sec X?

III 1.1( k I 1st ... An

Untitled for Test

The following dialog box will appear:

Page 7 of 15
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Intelligent Questionnaire With The WriteOne v1.3

aill3 Question 10 Names
:Find

Untitled for Test Se*
PNums
Pitott?1
Smoking
Packs/dag

Double-click the II) Name corresponding to the placeholder.

[PName] states that [PRef] [smokes]4

becomes, after editing (the PRef we want is in "column 2"),

«PName* states that «PRef[2]* «Smoking*

The Resulting QUESTONNAME...

Question List i Ouestionneire Controls
:7713-21

lUrnirliIt =II
(a1111L1.11 I

(=OR

I
ow

Pseits/day

loso SOU!

N ditor
M I Herm )
datitiod tor Test

OK

OK IP Newt

Uhat is Preferred None?

Iaswors
Shift keg enables: Editor (Return sod Orrow) Neva
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Intelligent Questionnaire With The WriteOne v1.3

1

I Chapter 12

Question List Questionnaire Controls

Meek lag
paciuMisy

Close
Hide Editor

File:

sure
Ina=11911

Revert

Untitled for Test

Mot ore Personal References?

o Or.
Mr.
Mrs.

o Ms.
Miss

answers
he

O she
o his
o her

9ue1tl0n Editor

10I Name: ; I'll P f Tgpe

()Single answer
0 Multiple

'Nestles Prompt: till=ffl
What ere Personal liefereneesT

answer rennet
0 Radio Button
0 Cheek loss
0 List
0 Edit Field
0 Phrase

, 0 show as list

answers
tr.
rs..
obv.

Mos
'phah

New ))

_
IA

Motif,
Imam
1 uplieet

M Group break.
Question Link

0 Linic:1
'CI WE

its 0
and
or

0 and
0 or g

and
or ( Centel )

thou tang) thru all!

Choice ler : vow
10 Nsmep.

rep 'Merge Teat isms es 40 Nome"

Or.
Primary:

SeCendIWV:
Or.

(Fum

Cancel
OK
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(10 Pic ker... )

(Func tions...) ( Macro Me, 1

I.

Intelligent Questionnaire With The WriteOne v1.3

s

Chapter 12

Choice for : "Filer

10 Name:
,r613 'Merge Taut' same es 610 Name

Primary:

4,
Quandary:

Mr.

Pkker...) Cancel

unc dons Macro 11116$...
OK

Etc.

0 atrrilli.fly
yurringt=rin
1 =s!Il

Question List --1 Huestionnake Cm:trots

CI
Peakit/disy

INURE:MINI

Clio:titled

.111=1111M
Mde ditor TTTT

File: j Oman j
for Test J

OK

OK 0 Nut
Oen the pat lent Sacks?

Answers

0 No .

0 Vile

i

L

Choice ter : °Smoking°

10 Nana:
ciao 'Mew Tsar same as 111 NoW

does net smoke
Primary:

4,
Secondary:

does not smoke

Cancel
OK
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(10 Pk ker..)

(run( tions...)

(10 Picker...)

unc None) MUM )
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Intelligent Questionnaire With The WriteOne v1.3

Chapter 12

Choice far : *Smokino

10 Name:

Primary:

Secondary:

Yes'
'Moro* Tear same as '10 Name'

smokes sc Packs/days

4a

smokes t Packs/days

Cancel

Macro Tilles...
OK

Question Editor

10 Name:1 r., fk s , (htt Type

0 Single Answer
0 Multiple

Question Prompt: ill Jr1.17111,

I

How many pecks per day does the patient
smoke?

(Dannsawdelor If:mitt:int

0 OWk Boss
i

[°0 ELdsit1 field
()Phrase

0 show as list

i answers
1

NOW ))
pock/day

I
peek/dej

i peek /ft
0 rj

Modifimam
miiEcti

Group break.
Question Link

DllinkileSmokInp 10... '
OK

Item:
0 and

2 0 or 0 or w
end,,,
or

--
( Cancel )

0 thrv any) thrill-FM

Choice for : Pecks/date

10 Name: tiTIlliI

4
lisms[3 'Merge Tent' Sem es '10 Nemo'

less then ems peck per day.
Primary:

Nir
Secondary:

less then one peck per day.

Cancel
OK
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Pic tier)
(fun( lions...) ( macro nos._ )

( "Mary states that she smokes about one pack of cigarettes a day.")

Intelligent Questionnaire With The Write One v.

Choice tar : " Packs/dor

10 Name: I - I pa( k 1.1

11110 'Merge Teat' same as 90 Name'

about one pack per day.
Primary:

Secondary:
about one peck per day.

Cancel
OK

Etc.

USING the Ouestionnalre:

1. Answer the Questionnaire-based answers for all document
merge fields. (One or more Questionnaires).

2. Merge Primary (or Secondary) language with the open
document.

Example:

1. Open the QUESTIONNAIRE(s)
AND
Questionnaire Document QB, STATIONERY in some order:

For this specific example,

We now have this Que-tionnaire Document

«Mame* states that stPRef[2]). *Smoking*.

2. ANSWER the Questionnaire...

Page 12 of 13

Chapter 12 6b

BEST COPY AVAILABLE



www.manaraa.com

1

Intelligent Questionnaire With The WriteOne v1.3

Chapter 12

Select/type the answers and click the OK 0 Next button.

111:171112311

111=11111

o IIFIZEIM=I=
I=IPS

Question List Questionnaire Controls

f
1 rq

/dog

Close Seim

4

Hide Editor Save Rs...

File: Revert

Untitled for Test ..

OK

OK IP Next

Uhat is Preferred Hose?

Answers
Shift key enables: Editor (Return end Arrow) keysi

g

.77r

,_
a question list 1-- questionnaire Controls
.

Ina
roadway

4jUntit1ed

1"TiliarIrn
Hide ditor

FUe: I Revert j
for Test 1

OK

OK IP Nod

Uhat are Personal References?

. Answers

0 Or. (3 he 13 his
El Mr. l'a she sher
['Mrs.
caMs.
a Miss
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Intelligent Questionnaire With The WriteOne v1.3

Chapter 12

'Prime
e /NW

Question List Questionnaire Controls

PeCitslesU

lose Save

1T11111111131 Save As...

File:
Untitled for Test

Revert

Does the patient Saoke?

Answers
()No

Yes-

, Lo

3 Question List Questionnaire Controls

C--617:1-1('fiare-1g
Side alter &we As...

File: Revert

15\. IUntitled for Test I
,

OK

OK 0 Nest
Noe awl; pocks per dov does the pot lent smoke?

Answers ,

0 < I pack/A811
1 poek/dog

0) 1 peck/dog

_ NS,

Page 14 of 15

67



www.manaraa.com

I.

Intelligent Questionnaire With The WriteOne v1.3

Chapter 12

VI

Question List Questionnaire Controls

e

e
e

f
Iry

Packs Aksj

*_,:i._...221.Ii_sle. j
Hide Editor annamo

File: Reuert j
fe s Untitled for Test

OK

OK 0 MINI

.
..

answers

3. aick the Hide Editor button for Questionnare...

4. From the «?>> menu, choose Merge Primary or Merge
Secondary (the same in this example).

New Questionnaire
leen Questionnaire X4

Fanctiona X5

Met lie VI Whil 11 .1, 6

Merge Secondery X?
II Pick List

Untitled for Test

Intelligent Questionnaire merges the answers from the Questionnaire
to the merge document!

«PNarne* states that «PRef[2]). «Smoking*

BECOMES, in this example...

Mary states that she smokes about one pack per day.
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Student: «Student FName» «Student LName» Date: «DATE(3)»

Instructor: «Instructor Name»
«CLR(«PtToto,O)»

Ainteractions among Staff and Children
A-1. Staff interact frequently with children showing affection,

interest, and respect.

«Interacto
A-2. Staff are available and responsive to children.

«Available»
A-3a. Staff speak with children in a friendly, courteous manner.

«Speak courteously»
A-3b. Staff talk with individual children, and encourange children of all

ages to use language.

«Talk with individual children»
A-4a. Staff treat children of all races, religions, family backgrounds,

and cultures equally with respect and consideration.

«Treat with equal respecb>
A-4b. Staff provide children of both sexes with equal opportunities to

take part in all activities.

«Treat with no gender bias»
A-5. Staff encourage independence in children as they are ready.

«Encourage independence»
A-6a. Staff use positive approaches to help children behave

constructively.

«Constructive behavion>
A-6b. Staff do not use physical punishment or other negative discipline

methods that hurt, frighten, or humiliate children.

«Non-punishing»
A-7. Overall sound of group is pleasant most of the time.

«Pleasant-sounding group»
A-8a. Children are generally comfortable, relaxed, happy, and involved

in play and other activities.

((Comfortable, relaxed & happp>
A-8b. Staff help children deal with anger, sadness, and frustration by
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comforting, identifying, reflecting feelings, and helping children
use words to solve their problems.

«Help with anger, sadness, fru»
A-9. Staff encourage prosocial behaviors in children such as

cooperating, helping, taking turns, talking to solve problems.

«Prosocial behavim
A-10. Staff expectations of children's social behavior are

developmentally appropriate.

<Appropriate expectations»
A-11. Children are encouraged to talk about feelings and ideas instead

of solving problems with force.

«Feelingsnot force*

«Grade Method»
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Student: Ralph Labrat

Instructor: Mary Grader

Date: Aug 11. 1995

A.Interactions among Staff and Children
A-1. Staff interact frequently with children showing affection,

interest, and respect.

Interactions by Ralph were partially met to criterion. These interactions needed
improvement:
He talks with and listen to individual children during activities and routines
(arriving/departing, eating).

A - 2 . Staff are available and responsive to children.

Ralph availability could be improved if these criteria were met:
Reassure crying toddlers.

A-3a. Staff speak with children in a friendly, courteous manner.

Ralph speaks courteously but would be improved by more attention to these
criteria:
Speak with individual children often.
He includes child in conversations; describe actions, experiences, and events;
listen and respond to children's comments and suggestions.

A-3b. Staff talk with individual children, and encourange children of all
ages to use language.

Talking with individual children was fully met to these criteria:
Ralph repeats infant sounds.

A-4a. Staff treat children uf all races, religions, family backgrounds,
and cultures equally with respect and consideration.

Ralph could improve showing treaunent of equal respect by improving to these
criteria:
Ralph initiates activities and discussions to build positive self-identity and teach
the value of differences.

A-4b. Staff provide children of both sexes with equal opportunities to
take part in all activities.

Improvement in showing no gender bias could be improve, for example:
Provide models, props, and visual images tht counter traditional sex-role
limitations (i.E., femal firefighters, male nurses, etc.).
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A-5. Staff encourage independence in children as they are ready.

These examples of encouraging independence by Ralph would improve
performance:
Older infants: fmger feeding self.

A-6a. Staff use positive approaches to help children behave
constructively.

Ralph, you definitely need to concentrate on these guidance methods to
encourage more constructive behavior:
Redirection.
Consistent, clear rules developed in conjunction with children and discussed
with them to make sure they understand.
Staff describe the situation to encourage children's evaluation of the problem
rather than impose the solution.

A-6b. Staff do not use physical punishment or other negative discipline
methods that hurt, frighten, or humiliate children.

Examples of non-punishing methods were could improve your performance:
Ralph does not force children to apologize or explain their behavior but help
children recognize another child's feelings.

A-7. Overall sound of group is pleasant most of the time.

A pleasant overall sound most of the time could be achieved if these situations
were observed:
Happy laughter, excitement, busy activity, relaxed talking.

A-8a. Children are generally comfortable, relaxed, happy, and involved
in play and other activities.

Ralph, you fully met this expectation.
A-8b. Staff help children deal with anger, sadness, and frustration by

comforting, identifying, reflecting feelings, and helping children
use words to solve their problems.

Ralph, you partially met this expectation.
A-9. Staff encourage prosocial behaviors in cnildren such as

cooperating, helping, taking turns, talking to solve problems.

These examples of prosocial behavior could help you fully meet criteria:
Adults model the desire behaviors.

A-10. Staff expectations of children's social behavior are
developmentally appropriate.

Your expectations of social behavior were partially met to criteria. Ralph, for
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example, you could:
Infants interact (look, touch gently, vocalize) feely with one another as Ralph
observes, alert to respond and model safe interaction when necessary.

A-11. Children are encouraged to talk about feelings and ideas instead
of solving problems with force.

Feelings, not force, was fully encouraged, for example:
Adults supply appropriate words for infants and toddlers to help them learn
ways to get along in a group.

71%
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ASEPSIS EVALUATION
«CLR(«PtTot»,0)»«gender»
Date: «DAM)» Student: «Student FName» «Student
Vame»

Patient: «Patient Name»

1. «Student FName» placed rheostat on floor. «place rheostat»

2. «Student FName» performs hand washing. «hand wash»

3. «he» wore personal protection. «personal protection»

4. «Student FName» maintained
dust-free operatory. «dust-free»

5. «he» disinfected all armamentarium that
cannot be sterilized. «disinfection»

6. «he» placed barriers on particular areas of unit. «barrier placement»

7. «Student FNameo prepared basis unit set-up. «basic set-up»

8. «Student FName» prepared braket-tray and
counter set-up. <<bracket-tray and counter

set-»

9. «Student FNameo covered bracket table. «cover bracket table»

10. «he» wore gloves, face mask, and glasses
during all intraoral procedures. owear gloves, etc»

11. «he» recognized and corrected breaks in aseptic chain. «break in aseptic chaino

12. «Student FName» maintained clean working area. «maintain clean area»

13. «he» prepared instruments and suppl8ies to
be autoclaved. «prepare for autoclave»

14. «he» prepared materials and equipment to
be disinfected. «prepare for disinfection»

15. «he» prepared prophy angle for sterilization. «prepare prophy angle»

16. «Student FName» prepared operatory. «prepare operatory»

COMMENTS:
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Grade: <aemplaterGradel»

/

Instructor Signature:

Student Signature:
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Ibk

ASEPSIS EVALUATION

Date: August 11, 1995 Student: Ralph Labrat

Patient: Labrat

1. Ralph placed rheostat on floor. Acceptable

2. Ralph performs hand washing. Acceptable

3. He wore personal protection. Acceptable

4. Ralph maintained
dust-free operatory. Acceptable

5. He disinfected all armamentariurn that
cannot be sterilized. Acceptable

6. He placed barriers on particular areas of unit. Acceptable

7. Ralph prepared basis unit set-up. Acceptable

8. Ralph prepared braket-tray and
counter set-up. Acceptable

9. Ralph covered bracket table. Acceptable

10. He wore gloves, face mask, and glasses
during all intraoral procedures. Acceptable

11. He recognized and corrected breaks in -aseptic chain. Acceptable

12. Ralph maintained clean working area. Acceptable

13. He prepared instruments and suppl8ies to
be autoclaved. Acceptable

14. He prepared materials and equipment to
be disinfected. Acceptable

15. He prepared prophy angle for sterilization. Acceptable

16. Ralph prepared operatory. Acceptable

COMMENTS:

Grade: Excellent

7
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Instructor Signature:

Student Signature:
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TARRANT COUNTY JUNIOR COLLEGE
MEDICAL RECORD TECHNOLOGY/MEDICAL CODING SPECIALIST

STUDENT EVALUATION
MRT 1472 MEDICAL CODING SPECIALIST CLINICAL

«CLR(«PtTot»,0)»«gender»
Student «Student FName» «Student LName»Facility «Facility»Dates: «Datefrom»
from to «Dateto»

ATTENDANCE
«Attendance»

Comments:

PUNCTUALITY
«Punctuality»

Comments:

PROFESSIONAL CONDUCT

DEPENDABILITY

APPEARANCE

GROOMING/HYGIENE & DRESS
«Grooming»

Comments:

INTERPERSONAL RELATIONS/COMMUNICATIONS

WORK RELATIONSHIPS
«Work relations»

Comments:

RESPONSE TO CONSTRUCTIVE CRITICISM
«Criticism»

Comments:

QUALITY OF WORK

ABILITY TO FOLLOW INSTRUCTIONS
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«Follow instructions»

Comments:

ORGANEATION AND COMPLETION OF WORK
«Organization»

Comments:

ABILITY TO WORK WITH SUPERVISION
«Supervision»

SCORE «Grade Method»

so
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TARRANT COUNTY JUNIOR COLLEGE
MEDICAL RECORD TECHNOLOGY/MEDICAL CODING SPECIALIST

STUDENT EVALUATION
MRT 1472 MEDICAL CODING SPECIALIST CLINICAL

Student Ralph Labrat Facility Labrat Dates: 212/95 from to
10/1/95

ATTENDANCE
Ralph was never abst..nt.

Comments:

PUNCTUALITY
Ralph was never latt.

Comments:

PROFESSIONAL CONDUCT

DEPENDABILITY

APPEARANCE

GROOMING/HYGIENE & DRESS
Ralph is always neat and well-groomed. He is professional. He always reports wearing
his I.D. Badge.

Comments:

INTERPERSONAL RELATIONS/COMMUNICATIONS

MBIIBELATIOSSHIES
Ralpn -lways friendly and relates well to all personnel. He is an excellent team worker.
(100% of the time).

Comments:

RESPONSE TO CONSTRUCTIVE CRITICISM
Ralph accepts guidance and criticism. He changes behavior to improve. He seeks out
constructive criticism and guidance.

Comments:
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QUALITY OF WORK

ABILITY TO FOLLOW INSTRUCTIONS
Ralph is extremely quick and has excellent comprehension.

Comments:

ORGANIZATION AND COMPLEIMDEAQRK
Ralph consistently completes all his work on time. He plans ahead. Ralph makes good
use of all of his time.

Comments:

ABILECUOMEK.EITEISLIEERSISKIN
The minimum amount of supervision is required for Ralph.

SCORE 100%
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Student: «Student FName» «Student ',Name» Date: «DATE(3)»

MED-SURG LI PRACTICUM PERFORMANCE EVALUATION
Grading Sheet (1:1) 600 points

«CLR(«TempToto,0)»«gendem

MEASURED CRITERIA
111114,

PROVIDER OF CARE *Provider of Care*/[150]
«relates theory data» «he» relates theory data for specific patient.
«initial asssessment» «Student FName» does initial assessment of each patient.
«formulates database» «be» formulates data base (chart, nursing care plan, shift report and

assessment.
«derives diagnoses» «he» derives appropriate nursing diagnoses.
«analyzes behavior>, «he» analyzes patient behavior to determine nursing goals and

interventions.
«provides interventions»«he» provides interventions based onscientific rationale and patient data.
«prioritizes» «he» prioritizes immediate, (nutrition/elimination, etc) and long-term

needs.
«individualized plan» che» devises individualized nursing care plan/discharge planning.
«completes procedures»«Student FName» completes procedures efficiently.
«safety precautions» «Student FName» carries out safety precautions.
«maintains comfort» «Student FName» maintains patient comfort.
«nursing measures» «he» evaluates +/- responses to nursing measures.
«ordered therapy» «be» evaluates +/- responses to ordered therapy.
«CDC guidelines» «Student FName» follows CDC guidelines.
Notations by Instructor:

Personal Cleanliness «Personal Cleanliness*/[30]
«provide privazy» «Student FName» provides privacy.
«prevents chilling» «Student FName» prevents chilling.

Assists with hygienic needs
«premeal prep» premeal preparation.
«oral care» oral care.
«cath careF, cath care.
«skin care» skin care.

Provides safe environment
«unit neat» unit neat and orderly.
«side rails» side rails as indicated.
«wheels locked» wheels locked and in place.
«linens safe» maintains linens safe & slcure.
Notations by Instructor:

Medication Administration «Medication Admin*/[30]
«follows procedure» «Student FName» follows procedure for hospital.
«drug information» «he» is prepared with drug information.
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«administer drug» «Student Rlame» administers drug/"5 rights."
«records properly» «he» records properly administration/response to patient.
Notations by Instructor:

Fluids and Mobility «Fluids & Mobility)./[30]
«fluid intake» «he» measures/records: type, amount, and time of fluid intake.
«output» «he» measures and records output
«body alignment» «he» supports, turns, and positions patient in correct body alignment
«exercise» «he» provides activt/passive exercise as indicated.
«transfers/ambulates» «Student FName» transfers/ambulates safely (stabilized, balance).
Notations by Instructor:

Li,calc «iv Care*/[30]
«IV pincedure» «Student FName» follows procedure.
«calculates infusion» «he» calculates and maintains infusion.
«dateshimes tubing» «he» dates/times tubing.
«records IV site» vhe» records appearance/location of IV site.
«electrolyte balance>, «be» assesses hydration/electrolyte balance.
«charts fluid» «Student FName» charts fluid amount left at end of "shift."
«charts pm» «he» charts on IV fluid recor : pm.
Notations by Instructor:

ROLE OF TEACHER 4( Role of Teacher*/[60]
«teaching interest» «he» assesses patient and family need for/interest in teaching.
«provides teaching» «be» provides teaching/learning activity utilizeing teaching principles.
«team collaboration» «Student FName» collaborates with health team in teaching.
«documents teaching» «he» documents patient/family response to teaching.
Notations by Instructor:

ROLE OF COMMUNICATOR 4( Role of Communicator*/[120]
«social communication»«be» uses social therapeutic communication and intervenes

aPProPriately.
«health team communication»Ae» communicates with health team in providing/evaluating

care.
«involves family» «he» involves family in planning care.
«updates care plan» «he» updates and revises hospital nursing care plan.
«records observations>whe» records appropriate observations/findings in nurses notes

(accuracy & legibility).
«follows instructions»«Student FName» demonstrates evidence of following instructions.
Notations by Instructor:

ROLE OF MANAGER/TIME MANAGEMENT *Role of Manager* 490]
«time frame» «he» manages care of 2-3 patients within appropriate time frame.
«priorities» «Student FName» sets priorities, reorganizing as necessary.
«completes tasks» «he» completes tasks within appropriate time frame.
«conserves supplies» «Student FName»utilizcs and conserves supplies appropriately.
«continuity of care» «he»assumes responsibility for maintaining continuity of care.
Notations by Instructor:
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ROLE OF MEMBER WITIN PROFESSION «Role of Member*/[60]
*staff presence» «he» functions effectively in presence of instructor/staff.
*independent» *he» demonstrates independent behavior.
*caring» «Student FName» demonstrates caring behaviors.
*confidential info» «he» protects patient/family rights concerning confidential information.
((policy adherence» *Student FName» adheres to established policy/procedures.
*appearance» 4<he» maintains professional appearance.
*punctual» cbe* assumes responsibility for punctuality.
Notations by Instructor:

GRADE = i(TemplaterGradelANSTRUCTOR: «Instnictor Name» DATE:

COMMENTS:

STUDENT: DATE:

COMMENTS:
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Student: Ralph Labrat Date: Aug 11. 1995

MED-SURG II PRACTICUM PERFORMANCE EVALUATION
Grading Sheet (1:1) 600 points

MEASURED CRITERIA

PROVIDER OF CARE fl/[150]
Excellent
Excellent
Excellent

assessment
Excellent
Excellent
Excellent
Excellent
Excellent
Excellent
Excellent
Excellent
Excellent
Excellent
Excellent
Notations

be relates theory data for specific patient.
Ralph does initial assessment of each patient.
he formulates data base (chart, nuising care plan, shift report and

he derives appropriate nursing diagnoses.
he analyzes patient behavior to detennine nursing goals and interventions.
he provides interventions based onscientific rationale and patient data.
he prioritizes immediate (nutrition/elimination, etc) and long-term needs.
he devises individualized nursing care plan/discharge planning.
Ralph completes Orocedures efficiently.
Ralph carries out safety precautions.
Ralph maintains patient comfort.
he evaluates +/- responses to nursing measures.
he evaluates +/- responses to ordered therapy.
Ralph follows CDC guidelines.

by Instructor:

Personal Cleanliness 29/(301
Excellent Ralph provides privacy.
Excellent Ralph prevents chilling.

Assists with hygienic needs
Excellent
Excellent
Excellent
Excellent

premeal preparation.
oral care.
cath care.
skin care.

Provides safe environment
Excellent unit neat and orderly.
Excellent side rails as indicated.
Excellent wheels locked and in place.
Excellent maintains linens safe & secure.
Notations by Instructor:

Medication Administration al/[30]
Excellent Ralph follows procedure for hospital.
Excellent he is prepared with drug information.
Excellent Ralph administers dnig/"5 rights."
Excellent he records properly administiation/response to patient.
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Notations by Instructor:

Fluids and Mobility 22/[30]
Excellent he measures/records: type, amount, and time of fluid intake.
Excellent he measures and records output.
Excellent he supports, turns, and positions patient in correct body alignment.
Excellent he provides active/passive exercise as indicated.
Excellent Ralph transfers/ambulates safely (stabilized, balance).
Notations by Instructor:

Ly,Caix aft/[30}
Excellent Ralph follows procedure.
Excellent he calculates and maintains infusion.
Excellent he dates/tithes tubing.
Excellent he tecords appearance/location of IV site.
Excellent he assesses hydration/electrolyte balance.
Excellent Ralph charts fluid amount left at end of "shift."
Excellent he charts on IV fluid record pm.
Notations by Instructor:

ROLE OF TEACHER 0/[60]
Excellent he assesses patient and family need for/interest in teaching.
Excellent he provides teaching/learning activity utilizeing teaching principles.
Excellent Ralph collaborates with health team in teaching.
Excellent he documents patient/family response to teaching.
Notations by Instructor:

ROLE OF COMMUNICATOR 110/[1201
Excellent he uses social therapeutic communication and intervenes appropriately.
Excellent he communicates with health team in providing/evaluating care.
Excellent he involves family in planning care.
Excellent he updates and revises hospital nursing care plan.
Excellent he records approptiate observations/findings in nurses notes

(accuracy & legibility).
Excellent Ralph demonstrates evidence of following instructions.
Notations by Instructor:

411111111111M,

ROLE OF MANAGER/TIME MANAGEMENT 29./[90]
Excellent he manages care of 2-3 patients within appropriate time frame.
Excellent Ralph sets priorities, reorganizing as necessary.
Excellent he completes tasks within appropriate time frame.
Excellent Ralphutilizes and conserves supplies appropriately.
Excellent heasstunes responsibility for maintaining continuity of care.
Notations by Instructor:

EQLE OF MEMBER WITIN PROFESSION 0/[60]
Excellent he functions effectively in presence of instructor/staff.
Excellent he demonstrates independent behavior.
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Excellent Ralph demonstrates caring behaviors.
Excellent he protects patient/family rights concerning confidential information
Excellent Ralph adheres to established policy/procedures.
Excellent he maintains pmfessional appearance.
Excellent he assumes responsibility for punctuality.
Notations by Instructor:

GRADE = C
INSTRUCTOR- Maly Grader

COMMENTS:

STUDENT:

COMMENTS:
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Student: «Student FName» «Student LName» Date: «DATE(3)»

Instructor: «Instructor Name»

PERFORMANCE EVALUATION:
«CLR(«PtToto,C)»«gender»

3 points
2 points
1 point
0 point

TASKS:

STERILE TECHNIQUE

Task performed satisfactorily without prompting.
Task performed satisfactorily with self-initiated correction.
Task performed satisfactorily 1 prompting statement.
Task performed incorrectly or with more than 1 prompting statement.

1 . WHIRLPOOL PROCEDURE
«water temp»
«antimicrobial»
«nms agitator»
«removes bandages»
«measures wound»
«documents wound»
«patient in water»
«soaks off dressing»
«adjusts agitator»

a.
b.
C.

a.
e.
f.

g.
h.
1.

«he» insures correct water temperature.
«Student FName» adds microbial agent to water, pm:.
«he» runs agitator after adding agent to water.
«he» correctly removes bandages and dressings.
«he» measures size, depth of wound, odor, color of tissue, dfamage.
«he» documents size, depth of wound, odoA color of tissue, drainage.
«Student FName» puts patient or part in water.
«he» allows dressings to soak off, pm a nd removes from whirlpool.
«he» adjusts height, direction and force of agitator flow for part being
ueated.

2 . SETTING UP STERILE FIELD
«washes bandsl» a. «he» washes «his» hands.
«creates sterile field» b. «Student FName» creates sterile field.
«preserve field» c. «he» places equipment and supplies in sterile field withouth touching

field, supplies or without crossing field.

3 . DEBRIDEMENT PROCEDURE
«washes hands2» a. «Student FName» washes «his» hands.
«remove from whirlpoolob. «Student FName» removes patient from whirlpool.
«dries area» c. «he» dries area with sterile towel, patting all around the wound.
«positions patient» d. «he» positions patient for dressing.
«washes hands3» e. «he» washes «his» hands.
«dons sterile wear» f. «he» dons sterile gloves, gown, mask, shield, goggles, booties, cap,

pm in correct sequence.
«Student FName» maintains sterility when obtaining Debridement«maintains sterilityl» g.

instruments.
«maintains sterility2» h. «Student FName» maintains sterility when performing Debridement

procedure.

4. STERILE DRESSING
«removes/replaces wearoa. «Student FName» removes gloves, washes hands, dons clean
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«applies antimicrobialob.

«applies bandage* c.

«removes wear* d.

«washes hands4* e.

5 . CLEAN UP
«dons gloves* a.
((cleans devices* b.
«dispose instruments*c.
«dispose materials* d.
«washes hands5* e.

GRADE = «GradeMethodo

sterile gloves, pm.
«Student FName*, while maintaining sterility, correctly applies
antimicrobial agent.
«Student FName*, while maintaining sterility, applies 4x4s, Kerlex,
Kling, tube gauze, Spandage, and ace wrap, prn.
«he* correctly degloves, removes mask, gown, shield, boots, cap, pm
in correct sequence.
«he* washes «his* hands.

«he* dons examining gloves.
«Student FName* cleans whirlp000l, chair, lift, stretcher, pm.
«Student FName* properly disposes of sharp instruments.
«he* properly disposes of contaminated materials.
«he» washes «his* hands.
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Student Ralph Labrat Date: Aug 11. 1995

Instructor. Mary Grader

PERFORMANCE EVALUATION: STERILE TECHNIQUE

3 points
2 points
1 point
0 point

TASKS:

Task performed satisfactorily without prompting.
Task performed satisfactorily with self-initiated correction.
Task performed satisfactorily 1 prompting statement.
Task performed incorrectly or with more than 1 prompting statement.

1 . WHIRLPOOL PROCEDURE
3 points a. He insures correct water temperature.
3 points b. Ralph adds microbial agent to water, prn.
3 points c. He runs agitator after adding agent to water.
3 points d. He correctly removes bandages and dressings.
3 points e. He measures size, depth of wound, odor, color of tissue, drainage.
3 points f. He documents size, depth of wound, odor, color of tissue, drainage.
3 points g . Ralph puts patient or part in water.
3 points h. He allows dressings to soak off, prn a nd removes from whirlpool.
3 points i. He adjusts height, direction and force of agitator flow for part being treated.

2 . SETTING UP STERILE FIELD
3 points a. He washes his hands.
3 points b. Ralph creates sterile field.
3 points c. He places equipment and supplies in sterile field withouth touching

field, supplies or without crossing field.

3 . DEBRIDEMENT PROCEDURE
3 points
3 points
3 points
3 points
3 points
.3 points

3 points
3 points

a. Ralph washes his hands.
b. Ralph removes patient from whirlpool.
c. He dries area with sterile towel, patting all around the wound.
d. He positions patient for dressing.
e. He washes his hands.
f. He dons sterile gloves, gown, mask, shield, goggles, booties, cap,

pm in correct sequence.
g. Ralph maintains sterility when obtaining Debridement instruments.
h. Ralph maintains sterility when performing Debridement

procedure.

4 . STERILE DRESSING
3 points a. Ralph removes glo . es, washes hands, dons clean

sterile gloves, pm.
3 points b. Ralph, while maintaining sterility, correctly applies
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3 points

3 points

3 points

S . CLEAN
3 points
3 points
3 points
3 points
3 points

GRADE = 100%

C.

d.

e.

UP
a.
b.
C.

d.
e.

antimicrobial agent.
Ralph, while maintaining sterility, applies 4x4s, Kerlex,
Kling, tube gauze, Spandage, and ace wrap, pm.
He correctly degloves, removes mask, gown, shield, boots, cap, prn
in correct sequence.
He washes his hands.

He dons examining gloves.
Ralph cleans whirlp000l, chair, lift, stretcher, pm.
Ralph properly disposes of sharp instruments.
He ptoperly disposes of contaminated materials.
He washes his bands.
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COMPETENCY EVALUATION
«CLR(«PtTot»,0)»
Student «Student FName» «Student LName» Evaluator «Evaluator Name» Date «Date»

Laboratory «Which evaluation»

Procedure «Procedure»

Patient # «Patient No.» Hospital «Hospital» Room # «Room No.»

Each area below is rated as:
0 Unacceptable
5 Needs Improvement

10 Acceptable

A "0" in any of these areas
results in a score of "0"
for that projection.

Identify Projection Projection # [project no]

Pre-Exposure Performance

1. Interpretation of Requisition
olnierpretation of Requisition»

2. Facilities Readiness
«Facilities Readiness»

3. Patient Care and Handling
«Patient Care & Handling0

linage Evaluation

4. Correct Film Size and Axis Alignment
<Correct Film Size & Axis Alig»

5. Correct Tube-Part-Film Alignment
«Correct Tube-Part-Film Align»

6. Correct Radiographic Positioning
«Correct Radiographic Position»

7. Correct Density, Contrast, and Defmition
«Correct density, contrast, de»

8. Correct Patient Identification and Markers
«Correct Patient ID & Markers»

9. Evidence of Radiation ProtectiOn (Boarders, Gonad Shields, etc.)
«Radiation Protectiono

10. Identification of Anatomical Structures Demonstrated
«ID Anatomical Structures»

Student's Signature Total Score «GradeMethodo
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COMPETENCY EVALUATION

Student Ralph Labrat Evaluator Mary Grader Date August 11,
1995

Laboratory Laboratory Evaluation

Procedure Upper Thoracic

Patient Hospital All Saints Cityview Room # 212

Each area below is rated as:
0 Unacceptable A "0" in any of these areas
5 Needs Improvement results in a score of "0"

10 Acceptable for that projection.

Identify Projection Projection # [project no]

Pre-Exposure Performance

1. Interpretation of Requisition
Needs Improvement SCORE 5

These performance objectives should be improved:
Recall the history on the requisition
Identify the procedure to be done
Recall the patient's name and age
Identify mode of transportation to the clinical area
Pronounce the patient's name (within reasonable limits)
Recall the appropriate routine projections

2. Facilities Readiness
Acceptable SCORE 10

You met each of these performance objectives well, Ralph:
Have radiographic table and other equipment clean and ready

3. Patient Care and Handling
Unacceptable SCORE 0

You need to improve on every one of these performance objectives:
Select the correct patient
Exhibit care for patient paraphernalia (I.V. tubes, etc.)
Talk with patient in a concerned, professional manner
Follow proper isolation procedure when appropriate
Explain examination to patient

jmage Evaluation
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4. Correct Film Size and Axis Alignment
Needs Improvement SCORE 5

These performance objectives should be improved:
Select the correct film size for the required projections

5. Correct Tube-Part-Film Alignment
Ac:ceptable SCORE 10

You met each of these performance objectives well, Ralph:
Align center of part to the center of the film
Center CR to the center of film
Angle the CR the proper amount and direction to the center of the film

6. Correct Radiographic Positioning
Needs Improvement SCORE 5

These performance objectives should be improved:
The body part in proper position

7. Correct Density, Contrast, and Definition
Acceptable SCORE 10

You met each of these performance objectives well, Ralph:
Proper density and contrast
Correct use of film, film holder, grid, etc.
No motion or artifacts

8 . Correct Patient Identification and Markers
Needs Improvement SCORE 5

These performance objectives should be improved:
Correct right or left markers are properly placed
Time and/or position markers correctly placed

9. Evidence of Radiation Protection (Boarders, Gonad Shields, etc.)
Acceptable SCORE 10

You met each of these performance objectives well, Ralph:
Demonstrate utilization of lead apron and gloves, if appropriate
Wear film badge as required

10. Identification of Anatomical Structures Demonstrated
Acceptable SCORE 10

You met each of these performance objectives well, Ralph:
Name the anatomical structures demonstrated on the radiograph

Student's Signature Total Score 70
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PERFORMANCE EVALUATION: OXYGEN ADMINISTRATION

Date: Lab «Lab Date» Clinical *Clinical Date» Agency *Agency Date»
Lab: Pass Fail Clinical: Pass Fail
Student Name: *Student FName» *Student LName»Instructor Name *Instnictor Name»
No. of times observed in clinical No. of times practiced in clinical
«CLR(«PtTot>>,0)»
PASSING CRITERIA:

Clinical evaulation requires 100% score for successful completion. Laboratory evaluation requires
90% or better on the procedure. Tasks indicated by * must receive at least 1 point or the evaluation
is terminated. Procedure must be performed within the designated time or the performance receives a
failing grade.

SCORING:
2 points
1 point
0 point
NA

Task performed satisfactorily without prompting.
Task performed satisfactorily with self-initiated correction.
Task performed incorrectly or with prompting required.
Task not applicable to the patient care situation.

TASKS:
1. Verifies the physician's order *Physician order»

2. Washes hands «Hand wash»
3. Obtains the required equipment

a. Oxygen flowmeter
b. Humidifier
c. Sterile water

d. Oxygen connecting tubing
e. Oxygen administration device
f. No Smoking Sign(s)

4. Identifies the patient

5. Explains the procedure to the patient

6. Adjusts the device to the ordered level
7 . Applies the device to the patient

8. Confirms the F102 as appropriate
9. Disposes of excess equipment

10. Leaves the patient area clean and safe
11. Washes hands before leaving room

* 12. Documents equipment, concentration,

or liter flow in the patient's chart «Documents patient chart»
SCORE:

*Which evaluation» oPtTob> points of possible 34: *GradeMethod»
TIME: «Duration» out of possible 20 minutes.

«Oxygen flowmeter»

«Humidifier»

«Sterile water»

«Oxygen connecting tubingo

«Oxygen administration device»
*No smoking sign»

*Identifies patient»

«Explain procedure»

*Adjust device»

*Applies the device»

«Confirms F102»

*Disposes excess equipmento

«Leaves area clean and safe»

*Washes hands before leaving»

STUDENT SIGNATURES: INSTRUCTOR SIGNATURES:

PEER: LAB:
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PERFORMANCE EVALUATION: OXYGEN ADMINISTRATION

Date: Lab 1/9/95
Lstuabd: il

enPtass
Fa

Name: Ralph Labrat
No. of times observed in clinical

Clinical 1/10/95 Agency 1/11/95
Clinical: Pass Fail

Instructor Name Mary Grader
No. of times practiced in clinical

PASSING CRITERIA:
Clinical evaulation requires 100% score for successful completion. Laboratory evaluation requires
90% or better on the procedure. Tasks indicated by * must receive at least 1 point or the evaluation
is terminated. Procedure must be performed within the designated time or the performance receives a
failing grade.

SCORING:
2 points
1 point
0 point
NA

Task performed satisfactorily without prompting.
Task performed satisfactorily with self-initiatedcorrection.
Task performed incorrectly or with prompting required.
Task not applicable to the patient care siLation.

TASKS:
1 . Verifies the physician's order
2 . Washes hands
3. Obtains the required equipment

a. Oxygen flowmeter
correction.

b. Humidifier
correction.

c. Sterile water

d. Oxygen connecting tubing

e. Oxygen administration device
f. No Smoking Sign(s)

4. Identifies the patient

5. Explains the procedure to the patient

6. Adjusts the device to the ordered level
7 . Applies the device to the patient

8 . Confirms the F102 as appropriate
9. Disposes of excess equipment

10. Leaves the patient area clean and safe

11. Washes hands before leaving room
correction.

* 12. Documents equipment, concentration,
or liter flow in the patient's chart Task performed satisfactorily

correction.
SCORE:

Task performed satisfactorily without prompting

Task performed satisfactorily without prompting

Task performed satisfactorily with self-initiated

Task performed satisfactorily with self-initiated

Task performed incorrectly or with prompting required.
Task performed incorrectly or with prompting required.

Task performed incorrectly or with prompting required.

Task performed satisfactorily without prompting

Task performed satisfactorily without prompting

Task performed satisfactorily without prompting

Taetc derformed satisfactorily without prompting

Task performed satisfactorily without prompting

Task performed satisfactorily without prompting

Task performed satisfactorily without prompting

Task performed satisfactorily without prompting

Task performed satisfactorily with self-initiated
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Peer 24 points of possible 34: 64%
TIME: 10 out of possible 20 minutes.

STUDENT SIGNATURES: INSTRUCTOR SIGNATURES:

PEER: LAB:
STUDENT: CLINICAL:
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Instructor: «Instructor Name» Student: «Student FName» «Student LName».

Quality of Performance: With 5 being the most positive response the rating is shown
beside each criterion stated.
«CLR(«PtTot0,0)»«gendero 5 = Outstanding

4 = Good
3 = Fair
2 = Poor
1 = Unacceptable
0 = Not applicable

I. PROFESSIONAL ATTITUDES EVALUATION

A. Interpersonal Relations
1. Towards patients

A. «he» shows interest in the patient.
B. «he» maintains confidentiality of information.

informatio»
C. By working quietly, «Student FName» showg

apprehension»
awareness of patient's fear and apprehension.

D. «he» shows concern for the pat: :nes safety.

2. Toward Surgeons
A. «Student FName» shows respect for

all surgeons.
B . «he» makes an effort to give service to all

personal»
surgeons regardless of personal feelings.

C. «he» takes objective criticism from surgeons
seriously and profitably.

D. «he» does not become emotionally upset when
criticized»
criticized by surgeons during the case.

3. Towards Administrative Personnel
A. «Student FNarne* shows professional

respect toward those for whom «he» works.
C. «he» is respectful and cooperative toward the

RN under whom «he» works.
B . «he» accepts criticism, asks questions

concerning improvement and indicates
appreciation for guidelines.

D. «Student FName» accepts assignments
without disagreements.

100

Rating

«interest in patient>
«confidentiality of

qawareness of

«concern for safety»

«respect for surgeons»

«service regardless

«take objective criticism»

«not emotional when

«professional respect»

«respect RN»

«accepts criticism»

«accepts assignments»
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4. Towards Other Personnel
A. «he» shares knowledge of procedure and

technique.
B. «he» communicates in a cheerful, friendly

cheerfully»
manner.

C. «Student FName» is generous with time
by helping others with their work.

D. «he» contributes to building group morale.

B. Degree of Dependability and Integrity
A. «he» arrives on time, begins work promptly.

promptly»
B . «he* notifies well in advance of expected

absence or tardiness.
C. «he» treats confidential information ethically

confiden»
regarding partients, peers and staff.

D. «Student FName» admits errors and
accepts responsibility for «his» own actions.

E. «he» remains on the case until work is
completed or relieved or given permission
to leave.

F. «he» abides by the Code of Ethics and
demonstrates professionalism.

G . «Student FName» follows hospital and
program pol»
program policies.

C. Degree of Stability
A. «Student FName» demonstrates emotional

Frustration»
control during frustrating or anger-
provoking situations.

B . «he» retains emotional control during
Emergencies»
emergencies.

C. «he» follows directions during emergencies.
emergencies»

D. «he» performs well under heavy workload.
E. «Student FName» does not allow personal

mood to affect performance.

D. Initiative
A. «he» seeks opportunities to perform tasks.
B . «he» shows interest and desire to

perform tasks.

101

r

«shares knowledge»

«communicates

«helps others»

«build morale»

«on time & work

qnotify of absence»

«maintain information

«admit errors»

«remain on case»

«abide Code of Ethics»

«follow hospital &

«emotional control

«emotional control

«direction during

«heavy workload»
«personal mood»

«seeks opportunity»
«interest to perform»
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C. «he» demonstrates personal goals and
goals»
success to be very important.

D. «he» prepares in advance for assignments by
reading preference cards and/or textbook.

E. «he» shows interest in learning new
proc»
procedures.

«demonstrate personal

«prepare in advance»

«interest in learning new

Performance Deficienciesthese deficiences need to be improved:

«Performance Deficiencies»

Recommendations of Evaluator:

«Recommendations»

Additional Comments: «Additional Comments»

Main Strengths: «Main Strengths»

Number of Absences: «Absenses»

Overall Grade: «GradeMethodo
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Instructor: Mary Grader Student: Ralph Labrat

Quality of Performance: With 5 being the most positive response the rating is shown
beside each criterion stated.

5 = Outstanding
4 = Good
3 = Fair
2 = Poor
1 = Unacceptable
0 = Not applicable

I. PROFESSIONAL ATTITUDES EVALUATION

A. Interpersonal Relations
1. Towards patients

A. He shows interest in the patient.
B . He maintains confidentiality of information.
C. By working quietly, Ralph shows

awareness of patient's fear and apprehension.
D. He shows concern for the patient's safety.

2. Toward Surgeons
A. Ralph shows respect for

all surgeons.
B . He makes an effort to give service to all

surgeons regardless of personal feelings.
C. He takes objective criticism from surgeons

seriously and profitably.
D. He does not become emotionally upset when

criticized by surgeons during the case.

3. Towards Administrative Personnel
A. Ralph shows professional

respect toward those for whom he works.
C. He is respectful and cooperative toward the

RN under whom he works.
B . He accepts criticism, asks questions

concerning improvement and indicates
appreciation for guidelines.

D. Ralph accepts assignments
without &agreements.

4. Towards Other Personnel
A. He shares knowledge of procedure and

technique.

Rating

Outstanding
Outstanding
Outstanding

Outstanding

Outstanding

Outstanding

Outstanding

Outstanding

Outstanding

Outstanding

Outstanding

Outstanding

Outstanding
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I.

He communicates in a cheerful, friendly Outstanding
manner.

C. Ralph is generous with time Outstanding
by helping others with their work.

D. He contributes to building group morale. Outstanding

B. Degree of Dependability and Integrity
A. He wives on time, begins work promptly. Outstanding
B . He notifies well in advance of expected Outstanding

absence or tardiness.
C. He treats confidential information ethically Outstanding

regarding partients, peers and staff.
D. Ralph admits errors and Outstanding

accepts responsibility for his own actions.
E. He remains on the case until work is Outstanding

completed or relieved or given permission
to leave.

F. He abides by the Code of Ethics and Outstanding
demonstrates professionalism.

G. Ralph follows hospital and Outstanding
program policies.

C. Degree of Stability
A. Ralph demonstrates emotional Outstanding

control during frustrating or anger-
provoking situations.

B . He retains emotional control during Outstanding
emergencies.

C. He follows directions during emergencies. Outstanding
D. He performs well under heavy workload. Outstanding
E. Ralph does not allow personal Outstanding

mood to affect performance.

D. Initiative
A. He seeks opportunities to perform tasks. Outstanding
B . He shows interest and desire to Outstanding

perform tasks.
C. He demonstrates personal goals and Outstanding

success to be very important.
D. He prepares in advance for assignments by Outstanding

reading preference cards and/or textbook.
E. He shows interest in learning new Outstanding

procedures.

Performance Deficienciesthese deficiences need to be improved:

Tardiness/Absenteeism
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Ethical behavior/Professionalism
. Ralph, you can't fmd your way out of the garage with the doors open!

Recommendations of Evaluator:

Improve communication skills
Seek opportunities to learn and perform tasks.

Additional Commenta: Try a lobotomy!

Main Strengths: Ralph, you a real sharp dresser!

Number of Absences:_a

Overall Grade: 100%


